
Alma December 2017 Release Notes

This Alma release provides numerous new features and enhancements. Some of these enhancements are a result of Idea
Exchange initiatives.

Download a PDF of the Release Notes – Note that the PDF includes the online help pages that describe the core
functionality of the new features.

Make the Most of This Release
Action Items

Option to Send/Not Send Vendor Letters for PO Lines – Do you sometimes want to send an order letter to the vendor, but in other
situations find it unnecessary to do so? Until now, you have been able to accomplish this only through workarounds such as making the PO
line purchase method Gift, Technical, or Purchase at Vendor System. Now, with any purchase method, you can choose whether or not you
want the PO line sent to the vendor.

Distribute General Electronic Services from the Network Zone – Institutions that share a Network Zone can now further consolidate the
general electronic services they provide and simplify their configuration by centrally managing these electronic services. General electronic
services can be configured in the Network Zone and then automatically distributed to member institutions.

New Analytics Usage Tracking Subject Area – Curious about how Analytics is being used in your institution? This new subject area allows
you to create various reports about the usage of Alma Analytics, using a wide range of parameters. Be sure to check out the ready-to-use
dashboard at: /shared/Alma/Analytics Usage Tracking/Dashboards

What's New
The following sections present the new and changed features in this release of Alma.

New Alma User Interface
More than 12,000 staff users and 500 institutions worldwide are now using Alma’s new interface. If you haven't yet started
using the new interface, now is the time to try it out. You can turn it on gradually for specific staff users, or decide to turn it
on for your entire institution (Click here for more information about enabling the new UI).

Note that the new interface will be turned on automatically for all Alma customers in January 2018, so take advantage of
the next couple of months to start using the new UI at your institution and share your feedback with us.
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Acquisitions
• Option to Send/Not Send Vendor Letters for PO Lines – You can determine whether to send a letter to the vendor for

each PO line that you define.

• Idea Exchange: Remove Historical License References – A resource may be removed from the license history in the
license's Inventory tab.

• Adding a License to a PO Line with No Inventory – You can add a license to an electronic PO line without inventory.

• Add Group Settings to a License – A group setting may be associated with a license for environments with multiple
campuses or libraries.

Resource Management
• Additional Staff Search Fields – The Additional Network Zone Staff Search Fields configuration option announced in

September was renamed Additional Staff Search Fields and is now available for all Alma institutions.

• Vocabulary Option for Other Classification Number in Browse Bibliographic Headings – When you select the Call
Number/Classifications heading type and Other Classification Number for source code in Browse Bibliographic
Headings, a new vocabulary option is available.

• 651 Authority Record Linking and Suggestions – For bibliographic records containing the 651 field with a second
indicator of 0, the system now checks LCNAMES in addition to LCSH.

• New Authority Search Indexes – New authority search indexes are being added for MARC 21, CNMARC, and
UNIMARC.

• Latin Displayed for Multiscript UNIMARC Records – For UNIMARC bibliographic records that contain multiple scripts
and have $7 ba in certain fields, Alma displays only the Latin script version wherever records appear, such as in
search results.

• List of Holdings Enhanced – Several columns on the List of Holdings page are now sortable and new filters were
added to the page.

• Additional Resource Management Enhancements.

Digital Resource Management
• Available Libraries Restricted According to Permissions – The libraries available from the Library drop-down list when

adding representations and top-level collections are now limited according to the user's permissions.

• Add Representations from Repository Search and MD Editor – You can add representations to bibliographic records
directly from the repository search and the MD Editor.

• Additional Digital Resource Management Enhancements

Fulfillment
• Notification Fees for Fines and Fees Notification Profile – You may configure the Fines and Fees Notification Profile to

charge a handling fee to patrons for sending the notification letter.

• Reading List Search and Sets – You can search for reading lists and create reading list sets.

Ex Libris, a ProQuest Company

2

https://knowledge.exlibrisgroup.com/Alma/Release_Notes/0099_2017/01_December_2017/Alma_December_2017_Release_Notes/01Acquisitions_-_December_2017_Enhancements#Option_to_Send.2FNot_Send_Vendor_Letters_for_PO_Lines
https://knowledge.exlibrisgroup.com/Alma/Release_Notes/0099_2017/01_December_2017/Alma_December_2017_Release_Notes/01Acquisitions_-_December_2017_Enhancements#Remove_Historical_License_References
https://knowledge.exlibrisgroup.com/Alma/Release_Notes/0099_2017/01_December_2017/Alma_December_2017_Release_Notes/01Acquisitions_-_December_2017_Enhancements#Adding_a_License_to_a_PO_Line_with_No_Inventory
https://knowledge.exlibrisgroup.com/Alma/Release_Notes/0099_2017/01_December_2017/Alma_December_2017_Release_Notes/01Acquisitions_-_December_2017_Enhancements#Add_Group_Settings_to_a_License
https://knowledge.exlibrisgroup.com/Alma/Release_Notes/0099_2017/01_December_2017/Alma_December_2017_Release_Notes/02Resource_Management_-_December_2017_Enhancements#Additional_Staff_Search_Fields
https://knowledge.exlibrisgroup.com/Alma/Release_Notes/0099_2017/01_December_2017/Alma_December_2017_Release_Notes/02Resource_Management_-_December_2017_Enhancements#Vocabulary_Option_for_Other_Classification_Number_in_Browse_Bibiliographic_Headings
https://knowledge.exlibrisgroup.com/Alma/Release_Notes/0099_2017/01_December_2017/Alma_December_2017_Release_Notes/02Resource_Management_-_December_2017_Enhancements#651_Authority_Record_Linking_and_Suggestions
https://knowledge.exlibrisgroup.com/Alma/Release_Notes/0099_2017/01_December_2017/Alma_December_2017_Release_Notes/02Resource_Management_-_December_2017_Enhancements#New_Authority_Search_Indexes
https://knowledge.exlibrisgroup.com/Alma/Release_Notes/0099_2017/01_December_2017/Alma_December_2017_Release_Notes/02Resource_Management_-_December_2017_Enhancements#Latin_Displayed_for_Multiscript_UNIMARC_Records
https://knowledge.exlibrisgroup.com/Alma/Release_Notes/0099_2017/01_December_2017/Alma_December_2017_Release_Notes/02Resource_Management_-_December_2017_Enhancements#List_of_Holdings_Enhanced
https://knowledge.exlibrisgroup.com/Alma/Release_Notes/0099_2017/01_December_2017/Alma_December_2017_Release_Notes/02Resource_Management_-_December_2017_Enhancements#Additional_Resource_Management_Enhancements
https://knowledge.exlibrisgroup.com/Alma/Release_Notes/0099_2017/01_December_2017/Alma_December_2017_Release_Notes/03Digital_Resource_Management_-_December_2017_Enhancements#Available_Libraries_Restricted_According_to_Permissions
https://knowledge.exlibrisgroup.com/Alma/Release_Notes/0099_2017/01_December_2017/Alma_December_2017_Release_Notes/03Digital_Resource_Management_-_December_2017_Enhancements#Add_Representations_from_Repository_Search_and_MD_Editor
https://knowledge.exlibrisgroup.com/Alma/Release_Notes/0099_2017/01_December_2017/Alma_December_2017_Release_Notes/03Digital_Resource_Management_-_December_2017_Enhancements#Additional_Digital_Resource_Management_Enhancements
https://knowledge.exlibrisgroup.com/Alma/Release_Notes/0099_2017/01_December_2017/Alma_December_2017_Release_Notes/04Fulfillment_-_December_2017_Enhancements#Notification_Fees_for_Fines_and_Fees_Notification_Profile
https://knowledge.exlibrisgroup.com/Alma/Release_Notes/0099_2017/01_December_2017/Alma_December_2017_Release_Notes/04Fulfillment_-_December_2017_Enhancements#Reading_List_Search_and_Sets


• Additional Fulfillment Enhancements

Resource Sharing
• Deactivating Resource Sharing Libraries – A resource sharing library may be set as temporarily inactive for borrowing

or lending requests.

• Additional Resource Sharing Enhancements

Collaborative Networks

• Idea Exchange: Distribute General Electronic Services from the Network Zone – General electronic services may be
created by the Network Zone and distributed automatically to the member institutions.

• License Negotiation When Content Differs Between Members – Within an acquisition network, the Network Zone may
record and manage different content for each member institution when the license type is Negotiation.

• Additional Collaborative Networks Enhancements

Analytics
• New Analytics Usage Tracking Subject Area – The Analytics Usage Tracking subject area allows you to create reports

concerning the usage of Alma Analytics.

• Additional Analytics Enhancements

Mobile

• Idea Exchange: Restore Scan In Items – Alma Mobile now provides a Restore option with Scan In for managing your
inventory.

Administration and Infrastructure
• Administration and Infrastructure Enhancements – Several administration and infrastructure enhancements were made

for the December release.

APIs
• The suppress_from_publishing field is now available for holdings records, in addition to bibliographic records.

• he Analytics API can retrieve directories as well as reports, both in the default Alma directory and in the institutional
folder. You can thus retrieve both the name and path of a report, eliminating the need to open a report in the Alma
Analytics interface to ascertain the full path in the report properties.
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• It is possible to use a POST call to create a new set based on a Boolean operator between two sets (logical/itemized).
The output is always an itemized set.

• BIBFRAME is now available through the API.

Alma-Summon Integration
The following improvements were made to Alma-Summon patron-facing pages:

• The Virtual Browse service is now supported on the Services page and allows patrons to virtually browse the library
shelf and find additional related records based on the holdings call number of the record.

• End users are now able to use the self-registration capabilities of the various social login methods to self-register and
access the Services page. For more information, see Social Login.

• You can now upload a clickable logo without having to edit and upload the entire customization package. To support
this functionality, the Upload Logo section was added to the Manage Customization Package tab on the View
Configuration page (Discovery > Display Configuration > Configure Views).

Content Operations
• Library of Congress Authorities Community Zone Updates

• New Electronic Collections Added to the Alma CKB

• No new external search resources were added.

We received notification of changes that are being made by the German National Library (DNB) to the GND
authority format. Since the changes that were made to the GND authorities include major structure and content
updates, these cannot be implemented in a gradual manner. Rather, they require a full update of all the authorities.
The changes must be therefore be handled in Alma as soon as the DNB incorporates them.

We concluded as a result of analysis that the most efficient way to adopt these changes in Alma is to reload the
entire set of GND authority records (in coordination with the DNB) as soon as these changes are ready. Our plan is
to handle this load in November/December. The reloading and indexing will begin on the 26th of November and is
expected to take two weeks. During this time, the GND authority records and related functionality may not be fully
available in Alma for use by your institution.

In addition, during this two-week period no users will be able to add new contributions or update existing electronic
collections in the Community Zone. There may also be a delay in updating NLI and BARE authority records from
external authority files.

We will update once the GND reload process is completed and contributions to the Community Zone can resume.

Note
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Known Issues
Current known issues related to the new Alma UI can be found here.

Next Release Sneak Preview
View a list of the features that are planned for the January 2018 release.
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Acquisitions - December 2017 Enhancements

Option to Send/Not Send Vendor Letters for PO Lines
When defining a PO line, you can now determine whether to send a letter to the vendor. For each acquisition method,
there are now two options: one that sends a letter to the vendor and one that does not. By default, the new options that
were created to support this functionality are disabled. They may be enabled from the Acquisition Method code table
(Configuration Menu > Acquisitions > Purchase Orders > Acquisition Method).

Once the options have been enabled, they are displayed in the Acquisition method drop-down list in the Purchase
Order Line Details.

Acquisition Methods
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See Configuring Acquisition Methods.

Remove Historical License References

Idea Exchange: In the Inventory tab of the license (Acquisitions > Acquisitions Infrastructure > Licenses),
a resource may now be removed from the license history.

See Adding an Amendment to a License.

PO Line Details - Acquisition Method

License Inventory
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Adding a License to a PO Line with No Inventory
You can now add a license to an electronic PO line without inventory. On an existing order, click Additional Order,
select Other Service - One Time in the Purchase Type drop-down list, and click Create PO Line. The License can be
selected on the Purchase Order Line Details page that follows.

See Manually Creating a PO Line.

Add Group Settings to a License
A group setting may now be associated with a license for environments with multiple campuses or libraries. The license
contains a new tab, Group Settings, for licenses of type License or Negotiation.The group may be added or removed.

See Editing Licenses or Amendments.

Purchase Order Line Details - Additional Order

Licenses - Group Settings
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Resource Management - December 2017 Enhancements

Additional Staff Search Fields
The Additional Network Zone Staff Search Fields configuration option announced in September is now available for
all Alma institutions. With this configuration option, you can customize five additional 9XX fields for staff search.
See Configuring Additional Staff Search Fields for more information.

Vocabulary Option for Other Classification Number in Browse
Bibiliographic Headings
When you select the Call Number/Classifications heading type and Other Classification Number for source code in
Browse Bibliographic Headings, a new vocabulary option is available. When you specify a specific vocabulary code, the
browse results that appear are determined by a vocabulary code match in the 084 $2. Previously, the browse results
would only show headings with no vocabulary specified in the 084 $2. See Browsing Bibliographic Headings for more
information.

651 Authority Record Linking and Suggestions
For bibliographic records containing the 651 field with a second indicator of 0, the system now checks LCNAMES in
addition to LCSH in the following situations:

• When linking bibliographic headings to authority records with Authorities - Link BIB Headings

This job first checks LCSH for a match. If no match is found, the job checks LCNAMES.

• When using F3 to check authority records for the 651 bibliographic field

Authority headings for both LCSH and LCNAMES are displayed on separate tabs when F3 is used.

• When browsing bibliographic headings, the new LCNAMES for 651 option is provided in the Vocabulary drop-down
list when Subjects is selected as the heading type.

See the 651 row on the Search Indexes page and the Subjects row on the Browsing Bibliographic Headings page for
more information.

Existing headings links will be updated to reflect this new capability in February 2018.

Note
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New Authority Search Indexes
New authority search indexes are being added for MARC 21, CNMARC, and UNIMARC effective with the re-indexing
being done in December. See MARC 21 Authority Search Index Mapping, UNIMARC 21 Authority Search Index
Mapping, and CNMARC 21 Authority Search Index Mapping for more information.

Latin Displayed for Multiscript UNIMARC Records
For UNIMARC bibliographic records that contain multiple scripts and have $7 ba in certain fields, Alma displays only the
Latin script version wherever records appear, such as in search results. See Working with Multiscript UNIMARC
Bibliographic Records for more information.

Since this capability requires re-indexing, you will notice this change in Alma after the re-indexing has completed at one
point in December.

List of Holdings Enhanced
The following enhancements were made to the List of Holdings page:

• The following columns on the List of Holdings page (Repository Search > Physical Titles > Holdings) are now
sortable:

◦ Library

◦ Location

◦ Call Number

◦ Access Number

• The Library and Location filters were added.

Additional Resource Management Enhancements
• The semi-annual re-indexing will be run during December.

• In the MD Editor, Ctrl-Shift-R was added as a hot key for the Release Record menu option.

• New indexes for CNMARC call numbers will be available after the December 2017 re-indexing. See Local Call
Numbers in the All Titles - CNMARC Bibliographic tables on the Search Indexes page for more information.

List of Holdings
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• The Resource Type indication in search results is now available for UNIMARC and CNMARC records. See Working
with the Resource Type Field for more information.

• A new scheduling option for four times per day was added to the general publishing profile. See Publishing and
Inventory Enrichment (General Publishing) for more information about general publishing.

• The general publishing profile can now be used to publish records in RDA/RDF. In Publishing Profiles (see Publishing
Profiles) , the Output Format field now includes the RDA/RDF format.

• The list of options for Proxy server type in the Resolver Proxy integration profile was expanded to include OpenAthens
Redirector and Biblio-PAM. See Resolver Proxies for more information.

• The general publishing profile (Resources > Publishing > Publishing Profiles) was enhanced with additional fields
that can be used for bibliographic and electronic inventory enrichment:

• The Information tab of the MD Editor now displays information in the language of the interface, if available. If it is not
available, the default language appears according to the specific MARC profile and record type. For more information,
see Navigating the MD Editor Page.

General Publishing Profiles - Data Enrichment
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• Subfield $c of field 200 in UNIMARC is now displayed as part of the title in the staff search results.

• In the staff search results, whether the data is from field 700 or 701 (UNIMARC – Creator), subfields $c (Additions to
Names Other than Dates) and $d (Roman Numerals) are now displayed in addition to $a (Entry Element) and $b (Part
of Name Other than Entry Element).

• UNIMARC 200 $d (Parallel Title Proper) was added to the title information in the staff search results.

• To enable the retrieval of records for a non-Roman text search, many 880 fields (Alternate Graphic Representation)
have been added to the bibliographic record Search section according to whatever is in the subfield 6 of the 880.

• A new advanced search index called Linked Institution was added. The options are Community or Network. Use
this for retrieving bibliographic records that are linked either to the Community Zone or to the Network Zone (member
institutions).

• The 830 $w (bibliographic record control number) is being indexed in December and will be searchable under the
Other System Number index.

• The UNIMARC 559 $a (added/other title) is being indexed in December and will be searchable under the Title index.

• The Relink to another bibliographic record option was added to the Physical Item Editor.

• The appearance of records in the MD Editor was enhanced to show what type of record is being edited.

MD Editor Information Tab

Relink to Another Bibliographic Record

Display of Record Type
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• For different title searches in repository search, the Update Date field now reflects the correct updated date of the
bibliographic record.

• The following call number standards are now supported and can now be used when the appropriate customer
parameters are set by Ex Libris:

◦ Tozzer

◦ Harvard Yenching

◦ Widener

◦ Other Schema (expanded options determined by the parameter set by Ex Libris)

These changes expand the options for browsing the shelf listing, viewing sorted call number repository search results,
and normalization when saving holdings records. See Browsing the Shelf Listing for more information.

Update Date Field
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Digital Resource Management - December 2017 Enhancements

Available Libraries Restricted According to Permissions
The libraries available from the Library drop-down list when adding representations and top-level collections are now
limited according to the user's permissions. If the user has permissions for only one library, no selection is possible.

Add Representations from Repository Search and MD Editor
You can now add representations to bibliographic records directly from the repository search and the MD Editor.

• When searching the repository, select Add Representation from the row actions:

• In the MD Editor, select Tools > MARC Bibliographic > Add Representation or click the Add Representation icon:

The Representation Details page appears, allowing you to enter information for the new representation.

Add Representation from the Repository Search

Add Representation from the MD Editor
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Additional Digital Resource Management Enhancements
• SRU now supports importing records in qualified Dublin Core format.

• In the field description of the visualization of a digital resource, the volumes and titles are now grouped as in the
description in field 505. That is, the subfields are taken from field 505 for creating the description element, exactly as
they are cataloged.
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Fulfillment - December 2017 Enhancements

Notification Fees for Fines and Fees Notification Profile
You may now configure the Fines and Fees Notification Profile to charge a handling fee to patrons for sending the
notification letter. The Fines/Fees Notification Profile has a new check box, Create Notification Fee. When this check box
is selected, the Notification Fee Amount field is also displayed. This is the fee being issued for the notification itself. When
Create Notification Fee is selected, the Notification Fee Amount becomes a mandatory field that must be greater than
zero.

The Fines/Fees Notification Profile List now includes a column to indicate that a notification fee has been added to the
profile.

Fines/Fees Notification Profile

Fines/Fees Notification Profile List
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The XSL of the FulFinesFeesNotificationLetter can be modified to display the notification fee amount. The value is found in
fine_fee_notification_fee_amount. The job report for the Fines/Fees Notification job includes new lines in the summary
for total records that succeeded/failed to create a notification fee, and a new section, Fees Notification - Handling Fee -
By Profile.

See Configuring Fines/Fees Notifications.

Reading List Search and Sets
You can now search for reading lists and create reading list sets.

• To search for reading lists, see Searching in Alma. The reading list search fields are described in Reading List Search
Fields.

• Search results appear on the Reading Lists Task List page in the new All tab. This tab contains all reading lists that
you can view in all of the other tabs. For more information, see Managing Reading Lists.

• You can create logical or itemized reading list sets the same way that you create any other sets. See Managing Search
Queries and Sets.

Additional Fulfillment Enhancements
• On the Reading Lists Task Page (see Managing Reading Lists), you can now search by last modified date (using a

range of two dates between which the list was last modified).

• The fields Chapter author, Chapter title, and Editor were added for physical items (books), in the Physical Item
Editor and the add non-repository citation page. Chapter was renamed Chapter number on these screens.

Fines/Fees Notification Job Report

Reading list sets are not useful on their own; however, in an upcoming release, Alma will introduce a job that can
configure a group of reading lists (in a reading list set).

Note
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• After rolling over a course, a link to the original course appears in the header on the Manage Course Information page.
For more about course rollover, see Configuring Course Loading.

• Idea Exchange: The patron ID field on the Patron Identification page now saves the list of patrons entered during the
current session, so that you can select from recent patrons each time you access the page. Due to privacy concerns,
this recent list is emptied each time you log out. See Selecting a Patron.

• In block preferences (Configuration menu > Fulfillment > Block preferences):

◦ The title was changed from Workbench preferences to Block preferences.

◦ Column widths were enlarged.

• The message, Patrons card has expired, was added to the Self Check Messages (Configuration Menu >
Fulfillment > Physical Fulfillment > Self Check Messages) so that it can be customized.

• Idea Exchange: If you attempt to return an item in Manage Patron Services that is checked out to a user other than
the one you are viewing, a popup with an option to cancel the operation appears.
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Resource Sharing - December 2017 Enhancements

Deactivating Resource Sharing Libraries
A resource sharing library may now be set as temporarily inactive for borrowing or lending requests. The resource sharing
information in the library details includes new check boxes, Temporary inactive for borrowing in the Borrowing Setup
section and Temporary Inactive for lending in the Lending Setup section. When the check box is selected, an optional
field, Inactive dates range, may also be completed. When the date range is selected, the library is inactive for borrowing or
lending requests only for the dates indicated. If the date range is left empty, the library remains inactive until the check box
is cleared. This inactive status blocks requests for this library regardless of whether they are created using the UI, an API,
or in Primo. For Primo users, the resource sharing request link is hidden. For users of the Alma UI, when requesting an
item, a message pops up informing the user: The resource sharing library is inactive for requests. You may click
Confirm to override the block and continue with the request.

Organization Unit Resource Sharing Information
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When sending a borrowing request to an ISO or NCIP peer-to-peer lending partner that has inactivated their resource
sharing library for lending, the status of the lending request is Rejected the borrower request. The borrowing request will
then have its status changed to Rejected by partner.

For more information, see Configuring Parameters of a Resource Sharing Library, Creating a Borrowing Request, and
Creating a Lending Request.

Additional Resource Sharing Enhancements
• The Requested Format field, which appears on borrowing and lending resource sharing requests, was added to the

borrowing and lending task lists.

• AuthenticationInput is now supported for NCIP v1, the same way it is already supported for NCIP v2.

• The Manage Fulfillment Options header from the resource sharing lending request and reading lists now includes the
following fields, when available, in the new UI:

◦ Article\Chapter Title

◦ Volume

◦ Issue

◦ Chapter

◦ Pages

◦ Year

◦ Note
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Collaborative Networks - December 2017 Enhancements

Distribute General Electronic Services from the Network Zone

Idea Exchange: General electronic services may now be created by the Network Zone and distributed automatically to
the member institutions. The existing job, Distribute Network Fulfillment Changes to Members, now includes
distribution of the general electronic services. The job is accessed from Fulfillment > Advanced Tools > Distribute
Fulfillment Network Configuration. The General Electronic Services page includes a new column, Shared, for
member institutions. The records marked as Shared are copied from the Network Zone institution and cannot be edited.

A new customer parameter, network_ges_distribution_members_behavior, controls what is done with the members'
GES records when the Network Zone's records are distributed. Valid values are: Remove, Deactivate, and None.
Remove removes all the local records. Deactivate retains the local records but deactivates them. None leaves all
previously existing records exactly as they were before the distribution.

For more information, see Configuring Fulfillment Information in the Network Zone.

License Negotiation When Content Differs Between Members
Within an acquisition network, the Network Zone institution may now record and manage different content for each
member institution when the license type is in Negotiation status. The member content is accessed from Acquisitions
> Acquisitions Infrastructure > Licenses, then editing the license and selecting the Negotiation Details tab. You can
either add a member or edit an existing member and select the appropriate content.

See Adding a Negotiation License or a Centrally Managed License or the presentation, Licenses and e-resources in the
consortial environment.

Summary Tab of a Member in Negotiation Details
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Additional Collaborative Network Enhancements
• In the MD Editor under File > Options, the Placement of new bibliographic records heading was changed

to Placement of new records and templates in the Options dialog box.
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Analytics - December 2017 Enhancements

New Analytics Usage Tracking Subject Area
The Analytics Usage Tracking subject area allows you to create reports concerning the usage of Alma Analytics. For more
information, see Analytics Usage Tracking.

Additional Analytics Enhancements
• The PO ERP Number field was added in the following locations:

◦ Physical Items > PO Line

◦ Cost Usage > PO Line

◦ Funds expenditure > PO Line

◦ E-Inventory > Portfolio PO Line

◦ E-Inventory > Electronic Collection PO Line

• The Coverage Information Combined and Summary Holding fields were added to Titles > Title Details. These fields
allow you to determine the coverage of journals when performing an overlap analysis for physical and electronic
inventory.

• The Group5 field was added to the LC classifications dimension in all subject areas in which it appears. This field
allows you to create reports using the fifth level of the hierarchy of LC classifications. Note that this level is not
available in the Classifications hierarchy field.

• The Total Events using LTI field was added to Leganto Student Usage > Student Usage and Student Weekly Usage.
It indicates the usage using a Learning Tools Interoperability (LTI) system.
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Mobile - December 2017 Enhancements

Restore Scan In Items

Idea Exchange: Alma Mobile now provides a Restore option with Scan In for managing your inventory. Similar to the
web-based version of Alma, items that are identified in a temporary location can be restored to their permanent locations
using this new mobile feature. See Using Scan In for more information.
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Administration and Infrastructure - December 2017 Enhancements
• A section was added to the SIS report to include counts for unchanged users in the total records processed.

Unchanged records are records that have been included in the SIS feed, but did not include any changes to existing
records and therefore did not cause any update to an existing record.

• Internal users that use external authentication methods such as SAML or LDAP that were locked are now unlocked if
the lock duration time has passed and the user enters correct credentials.

• You can now create institution notifications. Unlike notifications that appear in the home page notifications widget
(which the user can hide), these notifications appear to all users at the top of the home page between certain dates or
until the user dismisses the notification. For more information, see Configuring Institution Notifications.

• In the new UI, if you customize the columns on a page, the configuration icon now has a small green dot in the lower
right corner

. When you click the icon, the option to Restore list defaults appears. Click to restore the fields and actions to their
out-of-the box settings.

• For non-repository searches (PO lines, funds, and so forth), which do not use the new UI's enhanced recent searches
feature, you may now be able to select a previous search string using your browser history. The enhanced recent
searches feature is still available for repository searches.

• Idea Exchange: In header section on any page, when a value is too long to display in the header, a partial value
appears with three dots (...). You can hover your mouse over the partial value to see the full value in a tooltip.
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Content Operations - December 2017 Enhancements

Library of Congress Authorities Community Zone Updates
The following are the Library of Congress subject authority updates for the period of October 19th through November 16th:

• Number of records updated: 57
• Number of records added: 206
• Number of records deleted: 21

The following are the Library of Congress name authority updates for the period of October 19th through November 16th:

• Number of records updated: 15369
• Number of records added: 23716
• Number of records deleted: 243

The following are the Canadian name authority updates for the period of October 19th through November 16th:

• Number of records updated: 179
• Number of records added: 1192
• Number of records deleted: 30

The following are the Library of Congress Genre/Form Terms (LCGFT) updates for the period of October 19th through
November 16th:

• Number of records updated: 4

New Electronic Collections Added to the Alma CKB
The following electronic collections were added to the Alma Community Zone from October 23rd through November 19th:

• Alexander Street Press 60 Minutes 1997-2014
• Alexander Street Press Academic Video Online Premium All Titles
• Alexander Street Press Academic Video Online Premium Australia
• Alexander Street Press Academic Video Online Premium Canada
• Alexander Street Press Academic Video Online Premium Japan
• Alexander Street Press Academic Video Online Premium Outside North America
• Alexander Street Press Academic Video Online Premium United States

The fix related to the 776 field that was announced in the Alma July 2017 release notes is now complete. All print
identifiers are now stored in the 776 $z (ISBN) or $x (ISSN) standard MARC fields instead of the non-standard MARC
subfields 020 or 022 $e. Note that this fix was handled in cooperation with the Community Zone Management Group
(CZMG).

Note
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• Alexander Street Press Alexander Street Drama
• Alexander Street Press Alexander Street Literature
• Alexander Street Press America Latina en Video All Titles
• Alexander Street Press America Latina en Video Canada
• Alexander Street Press America Latina en Video China
• Alexander Street Press America Latina En Video Outside North America
• Alexander Street Press America Latina en Video United States
• Alexander Street Press American History in Video Australia
• Alexander Street Press American History in Video Canada
• Alexander Street Press American History in Video China
• Alexander Street Press American History in Video Outside North America
• Alexander Street Press American History in Video United States
• Alexander Street Press Anthropological Fieldwork Online
• Alexander Street Press Art and Architecture in Video Australia
• Alexander Street Press Art and Architecture in Video Canada
• Alexander Street Press Art and Architecture in Video United States
• Alexander Street Press Asian Film Online Volume 1 Australia
• Alexander Street Press Asian Film Online Volume 1 Canada
• Alexander Street Press Asian Film Online Volume 1 United States
• Alexander Street Press Asian Film Online Volume 2 All Titles
• Alexander Street Press Asian Film Online Volume 2 Australia
• Alexander Street Press Asian Film Online Volume 2 Canada
• Alexander Street Press Asian Film Online Volume 2 United States
• Alexander Street Press Australasian Literature Online All Titles
• Alexander Street Press Australasian Literature Online Australia
• Alexander Street Press Australasian Literature Online Canada
• Alexander Street Press Australasian Literature Online United States
• Alexander Street Press Australasian Video Online All Titles
• Alexander Street Press Australasian Video Online Australia
• Alexander Street Press Australasian Video Online Canada
• Alexander Street Press Australasian Video Online United States
• Alexander Street Press Black Studies in Video All Titles
• Alexander Street Press Black Studies in Video Australia
• Alexander Street Press Black Studies in Video Canada
• Alexander Street Press Black Studies in Video China
• Alexander Street Press Black Studies in Video Middle East
• Alexander Street Press Black Studies in Video Outside North America
• Alexander Street Press Black Studies in Video United States
• Alexander Street Press Border and Migration Studies Online
• Alexander Street Press Border and Migration Studies Online Text
• Alexander Street Press Business Ebooks Online
• Alexander Street Press Business Education in Video North America
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• Alexander Street Press Business Education in Video Outside North America
• Alexander Street Press Counseling and Therapy in Video Volume 3
• Alexander Street Press Current Affairs in Video All Titles
• Alexander Street Press Current Affairs in Video Australia
• Alexander Street Press Current Affairs in Video Canada
• Alexander Street Press Current Affairs in Video Outside North America
• Alexander Street Press Current Affairs in Video United States
• Alexander Street Press Dance Online: Dance in Video Volume 2 Canada
• Alexander Street Press Deman Driven Acquisition
• Alexander Street Press Demand Driven Acquisition Exclusive Content Canada
• Alexander Street Press Demand Driven Acquisition Exclusive Content China
• Alexander Street Press Demand Driven Acquisition Feature Film All Titles
• Alexander Street Press Demand Driven Acquisition Feature Film Canada
• Alexander Street Press Demand-Driven Acquisition Feature Film China
• Alexander Street Press Dental Education in Video
• Alexander Street Press Diagnosing Mental Disorders DSM-5™ and ICD-10
• Alexander Street Press Disability in The Modern World
• Alexander Street Press Disability in The Modern World Video
• Alexander Street Press education in video volume 1 outside north america
• Alexander Street Press Education in Video Volume 2 Australia
• Alexander Street Press Education in Video Volume 2 Canada
• Alexander Street Press Education in Video Volume 2 United States
• Alexander Street Press Engineering Case Studies Online Text
• Alexander Street Press Engineering Case Studies Online Video China
• Alexander Street Press Environmental Studies in Video All Titles
• Alexander Street Press Environmental Studies in Video Australia
• Alexander Street Press Environmental Studies in Video Canada
• Alexander Street Press Environmental Studies in Video United States
• Alexander Street Press Ethnographic Video Online Volume 1 All Titles
• Alexander Street Press Ethnographic Video Online Volume 1 Australia
• Alexander Street Press Ethnographic Video Online Volume 1 Canada
• Alexander Street Press Ethnographic Video Online Volume 1 China
• Alexander Street Press Ethnographic Video Online Volume 1 Malaysia
• Alexander Street Press Ethnographic Video Online Volume 1 Middle East
• Alexander Street Press ethnographic video online volume 1 united states
• Alexander Street Press Ethnographic Video Online Volume 2 All Titles
• Alexander Street Press Ethnographic Video Online Volume 2 Australia
• Alexander Street Press Ethnographic Video Online Volume 2 Canada
• Alexander Street Press ethnographic video online volume 2 united states
• Alexander Street Press Ethnographic Video Online Volume 3 All Titles
• Alexander Street Press Ethnographic Video Online Volume 3 Australia
• Alexander Street Press Ethnographic Video Online Volume 3 Canada
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• Alexander Street Press Ethnographic Video Online Volume 4 All Titles
• Alexander Street Press Ethnographic Video Online Volume 4 Australia
• Alexander Street Press Ethnographic Video Online Volume 4 Canada
• Alexander Street Press Evidence Based Acquisition
• Alexander Street Press Film Scripts Online Volume 2
• Alexander Street Press Filmmakers Library Online Volume 2 Outside North Amercia
• Alexander Street Press Filmmakers Library Online Volume 3
• Alexander Street Press Food Studies Online Text
• Alexander Street Press Food Studies Online Video All Titles
• Alexander Street Press Food Studies Online Video Australia
• Alexander Street Press Food Studies Online Video Canada
• Alexander Street Press Food Studies Online Video China
• Alexander Street Press Food Studies Online Video United States
• Alexander Street Press Harpers Weekly 1857-1912
• Alexander Street Press Health and Society in Video All Titles
• Alexander Street Press Health and Society in Video Australia
• Alexander Street Press Health and Society in Video Canada
• Alexander Street Press Health and Society in Video United States
• Alexander Street Press Human Resource Management Online
• Alexander Street Press Human Rights Studies Online Text
• Alexander Street Press Human Rights Studies Online Video Australia
• Alexander Street Press Human Rights Studies Online Video Canada
• Alexander Street Press Images of America
• Alexander Street Press international Business Online
• Alexander Street Press LGBT Studies in Video All Titles
• Alexander Street Press LGBT Studies in Video Australia
• Alexander Street Press LGBT Studies in Video Canada
• Alexander Street Press LGBT Studies in Video China
• Alexander Street Press LGBT Studies in Video Outside North America
• Alexander Street Press LGBT Studies in Video United States
• Alexander Street Press March of Time
• Alexander Street Press Medical Imaging in Video
• Alexander Street Press Meet The Press
• Alexander Street Press Music Online Classical Music Library United States
• Alexander Street Press Music Online Classical Music Reference Library
• Alexander Street Press Music Online Classical Scores Library Volume 1 DFG
• Alexander Street Press Music Online Classical Scores Library Volume 3
• Alexander Street Press Music Online Jazz Music Library United States
• Alexander Street Press Music Online: American Song Canada
• Alexander Street Press Music Online: American Song Japan
• Alexander Street Press Music Online: American Song United States
• Alexander Street Press Music Online: Classical Music in Video
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• Alexander Street Press Music Online: Classical Music Library Canada
• Alexander Street Press Music Online: Classical Music Library Japan
• Alexander Street Press Music Online: Classical Performance in Video
• Alexander Street Press Music Online: Jazz Music Library Australia
• Alexander Street Press Music Online: Jazz Music Library Canada
• Alexander Street Press Music Online: Jazz Music Library Japan
• Alexander Street Press North American indian Drama Second Edition
• Alexander Street Press North American Indian Thought and Culture
• Alexander Street Press Nursing Assessment in Video
• Alexander Street Press Nursing Assistant Education in Video
• Alexander Street Press Nursing Education in Video 2013
• Alexander Street Press Nursing Education in Video 2014 All Titles
• Alexander Street Press Public Library Video Online
• Alexander Street Press Public Library Video Online Premium
• Alexander Street Press Romanticism Redefined
• Alexander Street Press Silent Film Online All Titles
• Alexander Street Press Silent Film Online Canada
• Alexander Street Press Silent Film Online Outside North America
• Alexander Street Press Silent Film Online Unitd States
• Alexander Street Press Sixties Primary Documents Personal Narratives 1960-1974
• Alexander Street Press Social Theory Second Edition
• Alexander Street Press South and Southeast Asian Literature
• Alexander Street Press Sports Medicine and Exercise Science in Video
• Alexander Street Press Teachers TV
• Alexander Street Press The BBC Video Collection All Titles
• Alexander Street Press The BBC Video Collection Australia
• Alexander Street Press The BBC Video Collection Canada
• Alexander Street Press The BBC Video Collection United States
• Alexander Street Press The Criterion Collection All Titles
• Alexander Street Press The Criterion Collection Canada
• Alexander Street Press The Criterion Collection United States
• Alexander Street Press The PBS Video Collection All Titles
• Alexander Street Press The Psychotherapy.net Collection
• Alexander Street Press Theatre in Video North America
• Alexander Street Press Theatre in Video Supplement
• Alexander Street Press Theatre in Video Volume 2 All Titles
• Alexander Street Press Theatre in Video Volume 2 Australia
• Alexander Street Press Theatre in Video Volume 2 Canada
• Alexander Street Press Theatre in Video Volume 2 United States
• Alexander Street Press Twentieth Century North American Drama First Ed
• Alexander Street Press Vast Academic Video Online All Titles
• Alexander Street Press Vast Academic Video Online Australia
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• Alexander Street Press Vast Academic Video Online Canada
• Alexander Street Press Vast Academic Video Online China
• Alexander Street Press Vast Academic Video Online Middle East
• Alexander Street Press Vast Academic Video Online Outside North America
• Alexander Street Press Vast Academic Video Online United States
• Alexander Street Press Veterinary Education in Video
• Alexander Street Press Video Journal of Counseling and Therapy
• Alexander Street Press Video Journal of Counseling and Therapy 2014
• Alexander Street Press World History in Video Australia
• Alexander Street Press World History in Video Canada
• Alexander Street Press World History in Video United States
• Alexander Street Press World Newsreels Online 1929-1966
• Early American News Series 1-13
• Early American Newspapers All Series & Editions
• Elibro via Ebook Central Arquitectura, Urbanismo y Diseño
• Elibro via Ebook Central Bellas Artes, Artes Visuales y Ciencias Semióticas
• Elibro via Ebook Central Biblioteca Digital Municipal
• Elibro via Ebook Central Biblioteca para abogados
• Elibro via Ebook Central Biblioteca para Contadores
• Elibro via Ebook Central Cátedra
• Elibro via Ebook Central Cengage
• Elibro via Ebook Central Ciencias Biológicas, Veterinarias y Silvoagropecuarias
• Elibro via Ebook Central Ciencias de la Información y de la Comunicación
• Elibro via Ebook Central Ciencias de la Salud
• Elibro via Ebook Central Ciencias Exactas y Naturales
• Elibro via Ebook Central Ciencias Sociales (incluye Leyes y Ciencias Políticas)
• Elibro via Ebook Central Classic Literature
• Elibro via Ebook Central Community College
• Elibro via Ebook Central Derecho Comparado
• Elibro via Ebook Central English
• Elibro via Ebook Central Ficción
• Elibro via Ebook Central Gedisa
• Elibro via Ebook Central Informática, Computación y Telecomunicaciones
• Elibro via Ebook Central Ingenierías y Tecnologías
• Elibro via Ebook Central McGraw Hill Especial
• Elibro via Ebook Central McGraw Hill Premium Library
• Elibro via Ebook Central Minha Biblioteca
• Elibro via Ebook Central Modalidad Compra
• Elibro via Ebook Central Negocios
• Elibro via Ebook Central Oxford
• Elibro via Ebook Central Pearson
• Elibro via Ebook Central Perpetual
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• Elibro via Ebook Central Portugués
• Elibro via Ebook Central Premium
• Elibro via Ebook Central Psicologia
• Elibro via Ebook Central Religion
• Elibro via Ebook Central Wolter Kluwer
• Elibro via Ebook Central_Ciencias Económicas y Administrativas (Elibro business)
• Elibro via Ebook Central_Escuelas Secundarias
• Elibro via Ebook Central_Grupo Patria
• Elibro via Ebook Central_Hispanics in US
• Elibro via Ebook Central_Interés General (incluye los clásicos de literatura)
• Elibro via Ebook Central_LGBT Studies
• Elibro via Ebook Central_Public Library
• Emerald Open Access
• Nexis Uni

• 中国学术期刊（网络版）

New External Search Resources
No new external search resources were added to Alma Community Zone for the December release.
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Next Release Sneak Preview

Acquisitions
• Enhanced Acquisitions Order Record Search Options – New enhanced PO line search options will enable a more

precise order record retrieval as well as the creation of better and more accurate PO line sets.

• Multi Year Negotiation License – When an institution uses a Network Zone-managed multiyear negotiation license, it
will be able to manage registering a price per year as well as a price increase. These fields will affect the calculated
price when the PO line is renewed in the institution.

• Update the PO Line’s Expected Receipt/Activation Date When Claiming – New functionality will recalculate the PO
line’s expected receipt/activation date after a claim is sent. In this way, additional claims can be sent at the time of the
new expected date.

• COUNTER in Alma – When an institution creates a local SUSHI account, it will be possible to contribute this local
SUSHI account to the Community Zone as a certified SUSHI vendor.

Resource Management
• Enhance General Publishing to Support Authority Records – The general publishing platform will be enhanced to

support the publishing of authority records.

Digital Resource Management
• Customizable DC Forms – Administrators will be able to create metadata forms for DCMI-family schema, to be

associated either with a staff-mediated deposit or adding a representation.

Resource Sharing
• Status Query and Report – It will be possible to trigger a status query for both borrowing and lending requests and to

automatically generate a status report when receiving a status query.

Analytics

The features below are currently planned for the next release. However, some of these features may, for various
reasons, not be included in this month's release, but rather in a future Alma release.

Note
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• Anonymize Patron Data in Analytics Reports – The analytics_anonymize_user_details parameter allows for
the anonymization of a patron’s private data in Analytics reports. This parameter, currently available for Network Zone
reports, will become a general option available for all levels of Analytic reports.

Administration
• Support Sharing of Templates Across the Community – A new Contribute action will be added to the MD Editor

templates, allowing for the sharing of record templates.

• Support for Sharing Publishing Profiles in the Network Zone/Community Zone – A new Contribute action will allow for
the sharing of general publishing profiles.

APIs
• API for Deleting Holdings Records – The new API for deleting a holdings record will be similar to the existing Delete

BIB API. It will use the same logic as UI/batch deletion, so that when the last holdings is deleted, a policy will determine
whether to suppress or delete the bibliographic record.

• Discovery APIs – A first set of APIs will be released as part of a process to supply a full set of APIs for using Alma
delivery options with third-party discovery tools. More APIs will follow in future releases.

• Webhook for Loans and Requests – The Webhooks integration profile will be enhanced to support changes to loans
(check-in/check-out, and so forth) and requests (placed/canceled/on hold shelf, and so forth.).
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Analytics Usage Tracking
New for December!

The Analytics Usage Tracking subject area allows you to create reports concerning the usage of Alma Analytics and is able
to answer the following types of business questions:

• Which Alma user ran Analytics reports/dashboards? When were the reports/dashboards run? Which reports/
dashboards were run (including a path to the reports)?

• How long did the reports take to run (total time in seconds)? How many times were the reports run (number of
queries)?

• Which percent of reports ended successfully or failed?

• Which subject areas are used the most? How many times were the subject areas used? How many users use the
subject areas? How long were queries run on each subject area?

• Which users use which specific subject areas?

• What is the analytics usage for a day of the week? an hour of the day? a week of the year? a month of the year?

Who ran Analytics reports/dashboards (which Alma user) ? when ? which reports/dashboards (included path to the
reports) ? how long did they run (total time in Sec.)? How many times were they run ? (Num of queries) Which percent
of reports ended successfully/fail ? Which subject areas are mostly used ? how many times ? how many users use them
? how long queries run on each SA ? Which specific users use specific subject areas ? What is the Analytics usage
regarding day of week ? hour of day ? week of the year ? month in the year ?

Analytics Usage Tracking
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Field Descriptions

Usage Tracking Measures
The Usage Tracking Measures table is a measures table that stores details on usage tracking.

Field Description Additional Information

Number of Queries The number of queries

Total Time in Seconds The total time the queries took in seconds

Query Details
The Query Details table is a dimension table that stores details on queries.

Field Description Additional Information

Data updated as of The last date the data was updated

Dashboard Name Thye name of the dashboard

Dashboard Tab The dashboard tab

Start Hour Min The start hour

Start Time The start time

End Hour Min The end hour

End Time The end time

Object Path Th eobject path

Query Status The query status

Subject Area The subject area

Analytics Usage Tracking - Field Descriptions
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Query Date
The Query Date table is a dimension table that stores details on the query date.

Field Description Additional Information

Query Date The query date

Query Day
Name

The query day name

Query Day of
Week

The query day of the week

Query Week
Number

The query week number

Query Month
Key

The query month (for example 2 for February)

Query Month The query month

Query Quarter The query quarter

Query Year The query year

Query Year
Month

The query year and month

Query
Fullmonth

Stores the month and the year of the date in a display
format such as Feb 12

This field is useful when comparing data on a month basis
between years.

Query Date
Filter

Used to filter reports by date

User Details
The User Details table is a dimension table that stores details on users.

Field Description Additional Information

External Id The external ID of the user

First Name The first name of the user

Full Name The full name of the user

Gender The gender of the user

Job Description The job description of the user

Job Title The job title of the user
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Field Description Additional Information

Last Name The last name of the user

Middle Name The middle name of the user

Primary Identifier The primary identifier of the user

Status The status of the user

User Group The user group of the user

User Id The user ID of the user

User Record Type The record type of the user

User Title The user title of the user

User Type The user type of the user

Institution
The shared Institution dimension allows the network institution to view reports according to institution. It is available in every
subject area. It contains the following fields:

Institution

Field Description Additional information

Institution Code The code of the institution.

Institution Name The name of the institution.

If an analytics report is run from a member institution in a collaborative network implementing a Network Zone, all member
institutions are included in the report for Institution Code and Institution Name.

If an analytics report is run from an institution that is not part of a collaborative network implementing a Network Zone, only
the single institution from which the report is run is included in the report for Institution Code and Institution Name.

Reports involving data across a collaborative network implementing a Network Zone may take longer to run than
reports within one institution.

Note

Ex Libris, a ProQuest Company

38


	Alma December 2017 Release Notes
	Make the Most of This Release
	What's New
	New Alma User Interface
	Acquisitions
	Resource Management
	Digital Resource Management
	Fulfillment
	Resource Sharing
	Collaborative Networks
	Analytics
	Mobile
	Administration and Infrastructure
	APIs
	Alma-Summon Integration

	Content Operations
	Known Issues
	Next Release Sneak Preview

	Acquisitions
	Option to Send/Not Send Vendor Letters for PO Lines
	Remove Historical License References
	Adding a License to a PO Line with No Inventory
	Add Group Settings to a License

	Resource Management -
	Additional Staff Search Fields
	Vocabulary Option for Other Classification Number in Browse Bibiliographic Headings
	651 Authority Record Linking and Suggestions
	New Authority Search Indexes
	Latin Displayed for Multiscript UNIMARC Records
	List of Holdings Enhanced
	Additional Resource Management Enhancements

	Digital Resource Management
	Available Libraries Restricted According to Permissions
	Add Representations from Repository Search and MD Editor
	Additional Digital Resource Management Enhancements

	Fulfillment
	Notification Fees for Fines and Fees Notification Profile
	Reading List Search and Sets
	Additional Fulfillment Enhancements

	Resource Sharing
	Deactivating Resource Sharing Libraries
	Additional Resource Sharing Enhancements

	Collaborative Networks
	Distribute General Electronic Services from the Network Zone
	License Negotiation When Content Differs Between Members
	Additional Collaborative Network Enhancements

	Analytics
	New Analytics Usage Tracking Subject Area
	Additional Analytics Enhancements

	Mobile
	Restore Scan In Items

	Administration and Infrastructure
	Content Operations
	Library of Congress Authorities Community Zone Updates
	New Electronic Collections Added to the Alma CKB
	New External Search Resources

	Next Release Sneak Preview
	Acquisitions
	Resource Management
	Digital Resource Management
	Resource Sharing 
	Analytics
	Administration
	APIs

	Analytics Usage Tracking
	Field Descriptions
	Usage Tracking Measures
	Query Details
	Query Date
	User Details
	Institution




